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1 Notes and symbols used in this Manual 

 

These paragraphs contain tips and practical advice for working with the System 

  

 

In the paragraphs highlighted with this symbol, you will find additional information and it is very 
important that you follow the instructions given. 

  

 

Documentation reference  
A user manual reference number is provided so the user can seek further assistance 

 

 

“Software Parameter” Monospaced text in quotation marks designates a software parameter, pages, 

tabs or tables in the 2D Software 

 

“#Channel” Monospaced text in quotation marks with a leading hash mark designates a 

channel in the 2D Software 

 

- cross-reference - Italic, dotted underlined text designates a cross-reference to a different Chapter 

of the manual 
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2 Desktop View 

A typical Analyzer desktop consists primarily of these 4 windows: 

• The main menu and the toolbar are in the header at the top of the screen.  

 

 

• The Overview window at the bottom of the screen is where you can view particular channel curves of 
the complete measurement. 

 

 

• The biggest window takes up the centre of the screen and is called the Moving window or the 

Survey window. It shows a detail, a section showing all the selected channels of a 

measurement  
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• The small Circuit window shows the current racing circuit and tells you which section is currently 
selected in the Moving window. 

 

 

• These are the typical windows, but you can also view a number of other windows that have layouts 
defined in the currently selected template. "Corners", for example, is a selectable view of the track: 
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3 Main Menu Items 

• The File menu contains a number of functions, including those loading and modifying 2D 
measurement files.  

• The Functions provides access to the basic and advanced analysis functions.  

• The View menu controls the desktop layout of Analyzer.  

• The Measurements menu enables you to change the way in which measurement data are displayed.  

• The Settings menu contains functions for program administration and settings for race events.  

• The Wizards menu launches a program for analyzing cornering sectors.  

• The Help menu takes you the help contexts. 

3.1 File Menu 

 

• Load measurement - Open 2D Explorer  

• Overlay lap - List of lap times in the current measurement. Possibility of loading another lap and 
comparing it with the current lap (lap overlay)  

• Remove active measurement  

• Exchange measurement - Replace the active measurement with another measurement selected with 
the 2D Explorer.  

• GoogleEarth link - View measurement data in GoogleEarth.  

• Screen export - Export all visible channels from the current section and compress them in a ZIP 
archive file.  

• Trim measurement - Trim off parts of the measurement or cut it into 2 parts.  

• Write section times to SpecSheet file - Enter the section times in the SpecSheet file that belongs to 
this measurement.  

• Restore original lap times - Reset the lap times to "as logged".  

• Comment - Add a measurement-specific comment to the SpecSheet file belonging to this 
measurement  

• 0-9: History list - View and select from a list of the 10 most recently loaded measurements.  

• Exit - Exit the Analyzer 
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3.2 Functions Menu 

 

 

• Overview - View the Overview window for the active measurement.  

• Section - View/activate the moving window.  

• Laps - Window with the lap times of the measurements currently loaded.  

• Section times - Section times of the active measurement.  

• Track - Window showing the circuit and the active section.  

• Multi-circuit - Race lines of all measurements mapped onto GoogleMaps images, zoom functions.  

• Track mode - Detailed view of the circuit showing certain sensor values in corners or on straights. 

• XY plot - 2-dimensional graphic plot of the relationship between two selected channels.  

• Min/max table - Lap-by-lap list of minima, maximum and average values.  

• Histogram - The measured-value statistics for a channel.  

• GPS - Definition of a starting line for lap generation. 

• Print report manager - Function for printing the screen views.  

• Measurements - Editor for channel settings  

• Active measurement - Define one of the measurements currently loaded as the active measurement  

• Run AutoCalc - Recalculate the virtual Calc channels.  

• Screenshot - Paste a screenshot of the current desktop to the clipboard. 
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3.3 View Menu 

 

 

• Quick bar - Hide/show the function bar at the right edge of the screen. 

• Big window - Full-size view of the moving and overview window. 

• Reset window positions - Reset to the last defined window position. 

• White background scheme - Set white as the background color. 

• Light background scheme - Set grey as the background color. 

• Dark background scheme - Set black as the background color. 
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3.4 Measurement Menu 

 

• Linked - Two or more loaded measurements are moved in synch in the Moving window.  

• Measure - Start/stop measuring mode. In measuring mode, the channel values at the mouse pointer 
position are shown as readings.  

• Distance plot - View channel transients plotted over distance (in meters).  

• Time plot - View channel transients plotted over time.  

• Previous selection - Show the preceding selection in the Moving window.  

• Zoom full lap - The current lap is shown in its entirety in the Moving window.  

• Jump to lap start - Shift the moving section to the start of the current lap.  

• Previous lap - Jump to the preceding lap.  

• Next lap - Jump to the next lap.  

• Jump to fastest lap - Move selection to the fastest lap in this measurement.  

• Synchronize - Synchronize all loaded measurements with the active measurement so that all 
measurements can be compared at a given lap position. 

 

3.5 Settings Menu 

 

• Language - Choice of 5 different languages German, English, French, Italian, Spanish.  

• Speed channel - Define the channel used to calculate the distance from speed.  

• Track - Circuit settings, e.g. type and length.  

• Printer setup - Options for the printer currently selected. 
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3.6 Wizards Menu 

 

• Detect track segments - Corners/straights on the circuit are detected on the basis of log data. 

 

3.7 Help Menu 

 

 

• Help - This Help resource.  

• Keyboard shortcuts - List of all keyboard shortcuts (hotkeys) in the Analyzer program.  

• Show hints - Show comments close to the mouse-pointer position in certain windows  

• Info - Show the Software Version information. 
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4 Toolbar Buttons 

4.1 File Functions 

 

 
Load measurement - Open 2D Explorer 

 
Overlay lap - List of lap times in the current measurement. Possibility of loading another lap and 
comparing it with the current lap (lap overlay) 

 
Remove active measurement 

 
Exchange measurement - Replace the active measurement with another measurement selected 
with the 2D Explorer. 

 

 

4.2 Basic Analyzer Functions 

 

 
Overview - View the Overview window for the active measurement.  

 Section - View/activate the Moving window.  

 
Laps - Window with the lap times of the measurements currently loaded.  

 
Track - Window showing the circuit and the active section.  
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4.3 Advanced Analyzer functions  

 

 
Track mode - Detailed view of the circuit showing certain sensor values in corners or on straights. 

 
XY plot - 2-dimensional graphic plot of the relationship between two selected channels.  

 
Min/max table - Lap-by-lap list of minima, maximum and average values.  

 Histogram - The measured-value statistics for a channel.  

4.4 Visibility of channels  

 

 
Channels - Editor for channel settings  

 
Groups - Particular channels can be grouped  

 

 

4.5 Additional functions 

 

 Quick bar - Hide/show the function bar at the right edge of the screen 

 

 

4.6 Templates 

 

 Templates list - Select a desktop layout 
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4.7 Measurement functions  

 

 

 
Linked - Two or more loaded measurements are moved in synch in the Moving window.  

 
Measure - Start/stop measuring mode. In measuring mode, the channel values at the mouse 
pointer position are shown as readings.  

 Distance plot - View channel transients plotted over distance (in meters).  

 
Time plot - View channel transients plotted over time.  

 
Previous selection - Show the preceding selection in the Moving window.  

 Zoom full lap - The current lap is shown in its entirety in the Moving window.  

 
Jump to fastest lap - Move selection to the fastest lap in this measurement.  

 
Previous lap - Jump to the preceding lap.  

 Next lap - Jump to the next lap.  

 
Synchronize - Synchronize all loaded measurements with the active measurement so that all 
measurements can be compared at a given lap position.  
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5 Program Modules 

5.1 Overview Window 

→ Quick overview of the entire measurement.  

Each measurement opened in the 2D Analyzer module is shown in a separate Overview window. The 

measured data of selected channels are graphed in the Overview window. The timing triggers for the lap times 

are shown accordingly. This provides a quick overview of possible problems affecting the vehicle or the logger. 

 

5.2 Moving Window 

→ Enables precise comparison between individual measurements with the added benefit of a survey 

option.  

The measurements opened in the Analyzer are all shown together in the Section window. Unlike an overview 

window, which shows the entire measurement, this window shows only a selected part of the measurement. 

This permits precision overlay of measurements so that the curves can be compared. 

 

A rectangle in the overview window indicates the position corresponding to the details shown in 
this window 

 

5.2.1 Measurement mode 

A special Analyzer mode in which the physical values corresponding to the current position of the mouse 

pointer are shown in a separate small measured-values window.  

Press the <space> or double-click to start measurement mode, <space>, <ESC> or double-click to end.  

You can use all the Analyzer functions in measurement mode. For example, you can resize of the section, 

load a different measurement, or remove a measurement.  

The measured-values window shows the measured physical values for a channel that correspond to the 

current position of the mouse pointer. 

 

This measured-values window shows either the measured values of all visible (activated) channels or all 

available channels. You can toggle between the two modes by clicking on the small black double arrow. This 

double arrow is in the header of the left column of the measured-values window.  

Double-click on a channel to hide or show the channel.  
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Channel Highlighting 
 
If you left-click on a measured value (not on the channel name) in the measured-values window 
and hold the mouse button down, the corresponding channel starts flashing in the  
Moving window. 
 
This makes it easier to identify the channel, particularly if you have loaded a number of 
measurements and have numerous channels visible for each. 

 

5.3 Channels 

In the Analyzer, each sensor that transmits measured values to the data logger is represented by a channel. 

A measurement consists of multiple channels. In addition, virtual channels are computed. 

 

Each channel has its own individual settings and users can change these settings. Numerous 
functions assist you in administrating channels. You also have the option of grouping certain 
channels. 

 

You access channel administration through the main menu, the toolbar or by pressing <ALT> + <U> . 

 

5.3.1 Channel administration 

 

 

 



 

This document is subject to change at 2D decision. 2D assumes no responsibility for any claims or damages arising out of the use of this document, or 

from the use of modules based on this document, including but not limited to claims or damages based on infringement of patents, copyrights or other 

intellectual property rights. 

2021-04-07 Analyzer First Steps Page 16 of 20 
 

 

Column Desciption 

Visibility Channel visible in the moving window  

Scaling Scaling visible (not editable)  

Overview Channel visible in Overview window (not editable)  

Lower limit / upper limit Physical lower and upper limits of the display (see below for editor)  

Colour Individual channel colour  

Reduce Type of data reduction in the Overview window (not editable)  

All All measured values are bands in the Moving window (not editable)  

Button Shortcut for hide/show channel (not editable)  

Hz Frequency for channel logging (not editable)  

Start  Channel membership of the "Start" group  

Ruler / Alarm Display a Ruler or Mark Specific Values  

 

5.3.2 Channel Properties 

You can open the editor for channel properties by clicking on the upper-limit or lower-limit column in channel 

administration. 
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5.4 Lap Times 

→ Table of all lap times across all the measurements now loaded.  

The first page shows a list of all lap times for all the measurements currently loaded. Each of these 

measurements has its own page with details of lap length in meters, plus start and end of lap. 

 

Invalid lap times are highlighted in light grey. This always applies if lap length does not match track length, as 

is the case with out-laps and in-laps on the circuit. 

 

Manually inserted laps are display with underscored text. 

 

If you click on a value in the table the corresponding lap is shown directly in the Moving window. The section 

in the Overview window changes accordingly. You can hit <DEL> or use the pop-up menu (right-click) to 

remove a lap you do not want to include. Use this function with discretion, because it can also have an effect 

on the Lap trigger position. 
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5.5 Section Times 

→ Table of all section times of a particular measurement 

 

Overview of the section times for the track as defined beforehand, lap by lap for all the 
measurements currently loaded. The sum of the best section times is the ideal lap time. 
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6 Program functions 

6.1 Defining a GPS start line 

If the track on which the data were logged is not recognized by the analyzer, you can define a GPS start line 

manually and save it in the table 2DTrkPos, which then can also be used in the Logger or GPS Module 

To create a GPS starting line you have to mark a position with the cursor in the measurement mode. (You can 

access measurement mode by double-clicking in the Section window.)  

Once you have a fix on a suitable position, left-click to activate it by setting a marker. 

 

The right-click to open the pop-up menu, select “Define GPS starting line” and save. 

 

 

  

  

Select a suitable position  
and activate it  
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If you want to save this GPS starting line permanently so that it will be available for use in future logs, you can 

include it permanently in the 2DTrkPos table: 

 

 

 

 


